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Accessibility Issues

The most common accessibility issues in Word are:

e Having images with no alternative text or identified as decorative.
e Not having Styles set

e Not have the language set

e Text Contrast

e Tables without headings

e Save as a TAGGED PDF

This document will provide instruction on each of these issues.

Locating the Accessibility checker

You will find the 'Check accessibility' on the Review Tab. [’*

Clicking on this will open a new panel on the right of the screen Check T
where any Errors the document may have. Clicking on any of the Accessibility
error, or warning, will active information on the error meaning Accessibility

and how to fix it.
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Alternative Text.
Locating where to add a description.

Ther are two way to add a description to an image quickly.
1) Right-click on the image
2) Scroll down the list to 'Edit Alt Text'

Link

Insert Caption...

iR =

h?l

Format Picture...

Or

1) Open the Accessibility Checker.
2) Click on the arrow beside the image listed under Errors.
3) Click 'Add a Description'

Errors

" Missing alternative text
Picture 19

> Image or object not inline () Recommended Actions

. Fl Add a description
Warnings = £escp

> Hard-to-read text contrast (1)
ﬂ Learn more

Writing good ALT text description

In some cases, providing poorly written ALT text description can be as bad as not
providing ALT text at all. Poorly written, ambiguous, or irrelevant ALT text can actually
worsen understanding of a page and cause confusion.

Determining appropriate ALT text is often a matter of personal interpretation and is
influenced by the context of the image (i.e. the accompanying text). However,
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following the guidelines below will help you to create effective alternate text for most
situations.

ALT text should typically:

o Be accurate and equivalent in presenting the same content and function as
presented by the image.

e Be succinct. This means the correct content and function of the image should
be presented as succinctly as is appropriate. Typically, no more than a few
words are necessary, though rarely a short sentence or two may be
appropriate.

e NOT be redundant or provide the exact same information as text within the
context of the image.

e NOT use the phrases "image of ..." or "graphic of ..." to describe the
image. It's usually apparent to the user that it is an image. And if the image is
conveying content, it is typically not necessary that the user knows that it is an
image that is conveying the content, as opposed to text.

The information in the bulleted list above is taken from WebAIM (April 2010).

When is ALT text not needed?

It is not always necessary or appropriate to add ALT text to images, such as in the
following situations:

o If an image is purely decorative and provides no useful information to the
user to aid them in understanding the content of the web page.

e If the information provided by the image is communicated
effectively elsewhere in the body text of the page. Often images (or
diagrams) are used to reinforce understanding and do not necessarily provide
any additional information. Providing ALT

. . . . . x
text in this situation would duplicate text Alt Text -

content. How would you describe this object and its
context to someone who is blind?
The information in the bulleted list above is taken

from WebAIM (April 2010). (1-2 sentences recommended)

_ o Decorative
Not needing an ALT description does not mean

you do not need to put something in the
description. Images that do not enhance or add to
the information in the text of the document should
be tagged as DECORATIVE.
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Styles

Styles are the default formatting set in the standard word file - Normal.dotm file that
all new document is based on. Screen readers use these to help identify a new
section, subsection or paragraph is. It also allows screen readers to navigate/jump to a
different section, without having it read everything. Using styles allows people using
screen readers to understand where they are in the document.

Styles can be found on the Home tab in the middle of the ribbon.

aapbca| AQBE aaBbca AaBbC AaBbCe

T MNormal | Title- Cri.. TMoSpac.. Headingl Heading2 |+

Styles M=

You can set styles in two ways.

Option 1

1. Set the required format (font, size, colour

o , aaBbcel| AABE aaBbca AaBbC
position on the page, etc.) on a piece of text

T Mormal £ Title- Cri...  TMaoSnac...  Headino 1

within the document. Optio'n 1) Update Normal to Match Selection
2. Right-click on a style to get the dropdown Option 2)£: Modify..
options Select All: (No Data)

Rename...

3. Click the first option in the list. 'Update
Normal to Match Selection.’

Remowve from Style Gallery

Add Gallery to Quick Access Toolbar

Option 2 Modify Style
Properties
1) Right-click on a style to get the Bame Nomal
. Style type: Paragraph £
dropdown options Stie based ons ino s >
2) Click the second option in the list e forlowing peagrapt. | T Nowmal :

Formatting

"MOdifyI Georgia Ve e 1 ou | —

I
11}
il
Il

lirth
+

I

3) From the popup box, you can set the |= ==&
font, text size, colour position, etc.
Sample Text Sample Text Sample Text Sample Text Sample Text Sample Text Sample
4) Click OK to get the style to update. Sl Toc Sl Tot Soml Tt Sl Pt Sl et Sl ot Sl
. Text Sample Text
5) Any text in the document that has
the Style applled WI“ aUtomatlca“y Font: (Default) Georgia, 12 pt, Font color: Custom Color[RGE(58,53,55]), Kern at 12 pt, Left
Line spacing: Multiple 1.08 li, Space

u pd ate to th e n eW fo rmat. After: 8 pt, Don't add space between paragraphs of the same style, Widow/Orphan control,

Style: Show in the Styles gallery

Add to the Styles gallery
@ Only in this document O Mew documents based on this template

Format = Cancel
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Recommended Styles

The University brand preferred fonts are Gotham Narrow Light for Heading and
Chronicle for the body of the text. These fonts are not necessarily available on your
home computer. These styles are the branded preferred alternative, but if they are
not you your computer please use Open Sana which is available on all computers.
Please use the preferred fonts if they are available to you.

Title - White

Font: Open Sans - (replace with Gotham Narrow Light if this font is on your
computer)

Font size: 20pt

Colour: white

Square background shape: Crimson  #990033 / 153 -0 - 51

Title - Crimson

Font: Open Sans - (replace with Gotham Narrow Light if this font is on your
computer)

Font size: 20pt

Colour: #990033 / 153-0- 51

Heading 1
Font: Open Sans - (replace with Gotham Narrow Light if this font is on your
computer)
Font size: 16pt
Colour: Crimson  #990033 / 153-0- 51

Heading 2
Font: Open Sans - (replace with Gotham Narrow Light if this font is on your
computer)
Font size: 14pt
Colour: Black #000000 / 0-0-0

Heading 3
Font: Open Sans - (replace with Gotham Narrow Light if this font is on your

computer)
Font size: 12pt underlined
Colour: Black #000000 / 0-0-0
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Normal
Font: Open Sans (replace with Chronicle if this font is on your computer)
Font size: 12pt
Colour: Dark Grey  #3A3537 / 58-53-55

Emphasis
Font: Open Sans (replace with Chronicle if this font is on your computer)
Font size: 12pt
Colour: Black #000000 / 0-0-0

Links
Left to default colour: How to add a Panopto link to a vVUWS site

Note: Crimson #9D2235/ 157 - 34 - 53 can only be used for links if the text size
is great than 14pt.

Adding your new styles to the Default Template
(NORMAL.dotm)

Although you can change the Styles in any document, to make a permanent change to
the default styles, you will need to edit the NORMAL.dotm.

Depending on your computer setup you may need to search for the NORMAL.dotm
file.

1) Open 'File Explorer'

2) Enter NORMAL.dotm in the search area (top right)

o = | Search Toals - O x
Home Share View Search o
« « 4 Il + Search Results in This PC w % Normal.dotre %

3) Once the search is complete, Right-click on the Normal file
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search v 9

w @ MNormal.dotr

Size: 187 KB
Authors: User
MormalEmail Size: 124 KB
.Iﬂ' Date modified: 15/09/2017 1:41 PM Authors: User
4) Right-click and select 'open file location' from the Rename

list.

5) Copy the URL (file address) e.g.
C:\Users\User\AppData\Roaming\Microsoft\Templates.

6) Paste the address into the address bar of File Explorer and press enter.

B B - | Accessibility Project

File Home Share View

&« v A | ChUsers\User\AppData\Roaming'\Microsoft\ Templates

el MName

NOTE: As soon as you press the Enter key the address will change.

Home Share View

« - » ThisPC » Local Disk (C:) » Users » User » AppData » Roaming * Microsoft » Templates

-~

~  MName Date modified Type

7) From the list, RIGHT-CLICK the file 'Normal' and select 'Open’

L[ Insert your first tab

[ﬂ—_ﬁ Open Motebook

8) The top of the file should have the heading Normal - Word

Marmal - Word

Developer Help
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NOTE: If you double click on the file and it open with the heading Document

Number? - Word, you have opened a copy of the template, and any changes

to the Styles will not be permanent.
Documentd - Word

Developer Help G

Setting The Language.

English Australia dictionary should be used for all documents. Word originally default
to English (United States) when installed.

Language

Mark selected text as:

To change this setting: <h (Aus

Afrikaans

1. Onthe Review Tab click on Language e

H H Alsatian [France]
2. Click on Set Proofing Language o zatian
3. Make sure English (Australia) is selected  Arbicitgeria

Arabic [Bahrain) W

4. C“Ck Set AS Defau‘t The speller and other proofing tools automatically use

. dictionaries of the selected language, if available.
5' CI|Ck OK |:| Do not check spelling or grammar

Detect language automatically

Set As Default Cancel

To have the Presently set as the default, you will
need to edit the NORMAL.dotm file - located:
C:\Users\User\AppData\Roaming\Microsoft\Templates.

Text Contrast

Using the template provided will address any Font colour contrast issues.

WCAG Level AAA requires a contrast ratio of at least 7:1 for normal text and 4.5:1 for
large text.

Large text is defined as 14 point (typically 18.66px) and bold or larger, or 18 point
(typically 24px) or larger.
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The Colour Contrast Analyser (CCA) helps you determine the legibility of text and the
contrast of visual elements, such as graphical controls and visual indicators. This is a
small app you download.

WebAIM Contrast Checker is online

Tables Without Headings

To make sure your tables are effective and accessible, you should only use them for
data, and not for visual layouts. By adding headers to your tables, you will improve
how your students navigate tables, especially if they use a screen reader.

When you select a Table in your document, it will activate the

Table Tool tab. Design

e Select the Design tab. File

e Atthe beginning of the ribbon, you will see the
Table Style options section.

e Make sure the Header Row is Ticked.

e Add meaningful Heading to the first row of the
table. (Use the style heading formats for the
text)

Home Insert Design

Header Row First Column

[ | Total Row [ | Last Column

Banded Rows || Banded Columns
Table 5tyle Options

Saving as a TAGGED PDF

When exporting as PDF, you must check your export settings to make sure that the
PDF will be tagged, as this will make sure the document is easy to navigate.

To export a Word document as a tagged PDF, go to "File," select "Save As" then select
PDF from the dropdown.

Depending on the computer and version of Word you are using,
You will notice either:

1) adialogue box, check "Best for electronic distribution and
accessibility."”
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@ Creative Cloud..,
[ OneDrive - Bla...

Devicas
Onling Locations - -Flfé Format: | PDF = Q
P : : ~
f 1D Best for electronic distributicn and accessibility |
A\ {uses Microsoft online service) i
"~ s
T Best for printing T
B Hide extension New Falder Cancel

Or

2) You will need to click on Options and make sure the "Enable Accessibility
and Reflow with tagged Adobe PDF."

r8 Acrobat PDFMaker v @ | Search Templates el
PDF Options EEE - o
Convert document information Size

[]create POFfA-1a: 2005 compliant file
Enable Accessibility and Reflow with tagged Adobe PDF
Create Bookmarks
Convert Word Headings to Bookmarks
[ convert Word Styles to Bookmarks
[ convert Word Bookmarks
Convert Comments

Page range

@) al
O Current page
Selection

(CiPage(s) From: |10 - Tor |10 o 3

Conce

L]

| Options Save Cancel
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